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In This Version 
This release of WBS SPI provides: 

• Support for WebSphere Application Server 6.1 (on Windows operating system, only partial support is 
provided. For details, refer to the section Known Problems, Limitations, and Workarounds.) 

• Support for Hardware Cluster Failover 

⎯ HP-UX MCSG Cluster 

• Improved error logging and fault tolerance in Discovery functionality 

• Support for AIX 5.3  

• Support for Intel Xeon 64 bit processor - EM64T  

• Support for HP-UX 11.23 Itanium  

Documentation Updates 
The first page of this release notes document contains the following identifying information: 

• Version number, which indicates the software version. 

• Publish date, which changes each time the document is updated. 

To check for recent updates or to verify that you are using the most recent edition, visit the following URL: 

http://ovweb.external.hp.com/lpe/doc_serv/ 

1 In the Product list, click the product name. 

2 In the Version list, click the version number. 

3 In the OS list, click the OS type. 

4 In the document list, click the document title. 

5 To retrieve the document, click Open or Download. 

NOTE: To view files in PDF format (*.pdf), Adobe Acrobat Reader must be installed on your system. To 
download Adobe Acrobat Reader, go to the following URL: 

http://www.adobe.com
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Installation Notes 

Software and Hardware Requirements 

Service Navigator is not required to run the WBS SPI. However, if you want to view service maps, Service 
Navigator must be installed. 

Management Servers 

Component Supported Versions 

HP OpenView Operations for UNIX 
 

7.1, 8.1, 8.2 
 

 

Managed Nodes 

Component 

 

Supported Versions 

 

WebSphere Application Server 4.0, 4.1 HP-UX 11.00, 11.11 
AIX 4.3.3, 5.1, 5.2, 5.3  
Solaris 7, 8 
Windows 2000 
Red Hat Enterprise Linux 2.1 AS/ES (32 bit) 

WebSphere Application Server 5.0 HP-UX 11.11, 11.23, 11.23 IA64 
AIX 4.3.3, 5.1, 5.2, 5.3  
Solaris 7, 8, 9, 10  
Windows 2000, 2003, 2003 IA64  
Red Hat Enterprise Linux AS/ES 2.1(32 bit), 
3.0 (32 bit) 

WebSphere Application Server 5.1 HP-UX 11.11, 11.23, 11.23 IA64 
AIX 5.1, 5.2, 5.3  
Solaris 7, 8, 9, 10  
Windows 2000, 2003, 2003 IA64 
Intel Xeon 64 bit processor - EM64T 
Red Hat Enterprise Linux AS/ES 2.1(32 bit), 
3.0 (32 bit), 4.0 (32 bit)  
SuSe Linux ES 8.0 (32 bit), 9.0 (32 bit) 

WebSphere Application Server 6.0 HP-UX 11.11, 11.23, 11.23 IA64 
AIX 5.1, 5.2, 5.3 
Solaris 7, 8, 9, 10 
Windows 2000, 2003, 2003 IA64 
Intel Xeon 64 bit processor - EM64T 
Red Hat Enterprise Linux AS/ES 2.1(32 bit), 
3.0 (32 bit), 4.0 (32 bit) 
SuSe Linux ES 8.0 (32 bit), 9.0 (32 bit) 

WebSphere Application Server 6.1 Note: Please see the footnote below the 
table 
HP-UX 11.11, 11.23, 11.23 IA64 
AIX 5.1, 5.2, 5.3 
Solaris 7, 8, 9, 10 
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Windows 2000, 2003, 2003 IA64
1

 
Intel Xeon 64 bit processor - EM64T 
Red Hat Enterprise Linux AS/ES 2.1(32 bit), 
3.0 (32 bit), 4.0 (32 bit) 
SuSe Linux ES 8.0 (32 bit), 9.0 (32 bit) 

HP OpenView Reporter 
 

2.x, 3.5, 3.6, 3.7 

HP OpenView Performance Insight 5.0, 5.1 

HP OpenView Performance Manager (HP-UX, 
Solaris, Windows) 
 

4.x, 5.x 
 

 

1 
WebSphere Application Server 6.1 is supported on Windows only if COLLECTOR_MODE is set as TRANSIENT. 

See the section Known Problems, Limitations, and Workarounds for details. 

Installation Requirements in a Non-Root HTTPS Agent Environment 

If you are running or planning to run a non-root HTTPS agent on a UNIX managed node (OVO 8.x only), you 
must install the OS-dependent Sudo software package on that UNIX managed node. Sudo is free software 
available from http://www.sudo.ws. The OS-dependent software packages are available at the bottom of the 
download page (http://www.sudo.ws/sudo/download.html). 

Enhancements and Fixes 
None 
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Known Problems, Limitations, and Workarounds 

• Problem: Two or more versions of the WebSphere application server are running on a managed node 
and discovery does not correctly set the properties for the application server(s). 

Workaround 1:   

1 Verify the application servers are using non-conflicting ports. If you install an application server in a 
different home directory, the installer may choose a port used by an existing application server (even 
if you set the installer to auto-configure non-conflicting ports). 

2 If application servers are using the same bootstrap port, modify the port numbers so that each 
application server uses a unique bootstrap port. 

3 Run the Discover application. 

Workaround 2:  If you want to use the same bootstrap port, run the Configure WBSSPI application and 
do the following: 

1 Set the HOME, JAVA_HOME, VERSION, and other properties that are incorrectly set. 

2 Set a unique ALIAS for each application server using the same port. 

3 Unselect the AUTO_DISCOVER check box for the application server that is not running. 

4 Select Finish. 

• Problem: In a non-English environment, the message browser does not display error messages 
correctly. 

Workaround:  Change the character set of the WBSSPI Error Log template and redeploy the template. 
For example, change the character set from “Shift-JIS” to “Japanese EUC.” 

• Problem: On managed nodes using the DCE agent, the /var/opt/OV/wasspi directory and SiteConfig 
file are not created when running the SPI Discovery or Configuration applications.  The problem may be 
that the component opctranm may be hung.   

Workaround:  On the management server, run the following commands: 

ovstop ovoacomm 
rm –f /var/opt/OV/share/tmp/OpC/mgmt_sv/magmgr* 
ovstart opc 
 

• Problem: When multiple managed nodes are selected when running the Discover WebSphere or 
Configure WebSphere applications, or if the Discover WebSphere and Configure WebSphere applications 
are run at the same time, the SPI may report errors for one or more selected managed nodes because the 
SPI configuration file (SiteConfig) for one or more managed nodes has been misplaced. 
(QXCR1000306403: Discover/Configure application may misplace the SPI configuration file on a 
managed node.) 

Workaround:  Run the Configure WebSphere application for each managed node that is reporting 
errors (run the application on each managed node one at a time). 

• Problem: When the Self-Healing Info application is run on a Windows managed node, the output file 
may be hidden. 

Workaround:  If you do not see the file, do the following on the managed node: 

1 Open Windows Explorer. 

2 From the Tools menu, select Folder Options.  

3 Click on the View tab.  
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4 Under Hidden files and folders, select Show hidden files and folders. 

• Problem: The perl installed with the OVO agent fails to find the OVO perl modules if another 
application (such as Oracle Application Server) sets the PERL5LIB environment variable to point at 
locations that do not include the OVO perl lib location.   

Workaround 1: Set the PERL5LIB system environment variable: 

1 Prepend C:\Program Files\HP OpenView\nonOV\perl\a\lib (the OVO perl lib path) to 
the PERL5LIB system environment variable.  

2 Kill the OVO agent: opcagt -kill  

3 Restart the OVO agent: opcagt -start  

4 Check the OVO environment: ovdeploy -cmd set  

5 If the PERL5LIB variable is not set correctly in the OVO environment but the system variable is 
set correctly, reboot the system. 

Workaround 2:  

1 Delete the PERL5LIB system environment variable.  

2 Reboot the system. 

3 Run the Discover application. 

Workaround 3: Run the discover script on the target node. Enter the following: 

1 cd /var/opt/OV/bin/instrumentation 

2 wasspi_wbs_perl –S wasspi_wbs_discovery.pl 

NOTE: The service map is not generated when the discover script is run locally (is not run from the 
OVO management server). 

• Problem: The wbs.log file grows very large.   

Workaround: Limit the size of the data saved to the log file each time the logfile encapsulator is run. In 
the SPIConfig file (located in /var/opt/OV/wasspi/wbs/conf/ or /var/opt/OV/conf/wbs/ on 
UNIX platforms and /usr/OV/wasspi/wbs/conf/ on Windows platforms), add the following: 

# maximum number of lines to save to the log file / run 
LOG_LINE_LIMIT=16667 
# maximum number of characters to save from each log file / run 
LOG_SIZE_PER_FILE_LIMIT=600000 

• Problem: Two Netscape Navigator browser windows are launched when running the View Graphs 
application. The top window obscures the OVPM function buttons in the lower window.  

Workaround:  This problem only occurs with Netscape Navigator version 4.79. Use Netscape Navigator 
version 6.0 or higher. 

• Problem: The Web browser cannot be launched from an operator action after you have correctly 
configured the WBS SPI as instructed in the “Configure the Management Server to Launch your Web 
Browser” task in chapter 2 of the HP OpenView Operations Smart Plug-in for WebSphere Application 
Server Configuration Guide.  

Workaround:   

1 Stop and restart the agent from a user other than root by entering the following commands on 
the managed node: 

opcagt –kill 
opcagt –start 
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2 Run the operator action.  

• Problem: Netscape fails to refresh graphing data. Specifically, when you use Netscape as the browser to 
graph your data (graphing capability included with Reporter 3.0 or higher), the browser fails to refresh 
when new selections are made.  

For example, in the OVO console after you drag and drop a managed node onto the WBSSPI Admin 
application View Graphs, Netscape appears and displays a blank WBS SPI graphing page where you can 
accept or change the following default selections: 

Server: MyServer_1 
Graph Name:  Serverstat 
Data Range: 7 Days (ending now) 

By clicking Draw, you successfully generate the graph.  

However, when you select a different server, let’s say MyServer_2, you see that the graph that appears 
after you click the Draw button is the same graph/data as the one you just viewed (for MyServer_1).  

 Workaround: 

1 In Netscape from the Edit menu select Preferences→Advanced→Cache. 

2 In the segment labeled Document in cache is compared to document on network, select radio 
button Never. 

3 After successfully generating the first WBS SPI graph, for any subsequent graphs, always 
change a minimum of two selections to refresh the data; for example select a different server and 
a different graph; or select a different graph and a different date range. Any two differing 
selections work to clear the current graph data from the browser cache. 

NOTE: The underlined text Refresh Graph Now at the bottom of the Web page does not work; when 
clicked, it may return the error: the parameter is incorrect. 

 

• Problem:  On a Solaris managed node, the ddflog and dsilog processes hang. The error message  
WASSPI-1: Unable to create the lock file /var/opt/OV/wasspi/wbs/datalog/ddflog.lck. File 

already exists. is reported and running the command ps –l shows that the ddflog_coda and ddflog or 
dsilog processes are hung. 

Workaround: On each Solaris managed node on which the problem occurs, do the following: 

4 In the /var/opt/OV/wasspi/wbs/conf/SPIConfig file, set the DATA_LOGGING_EXECUTABLE_NAME 
property after the “#--------- Dynamic definitions -----------“ entry. DATA_LOGGING_EXECUTABLE_NAME 
explicitly sets the data logging program that is used (normally, the collector automatically 
determines the data logging program to use). 

If you are running OVPA, set the property to the following value: 

DATA_LOGGING_EXECUTABLE_NAME=/opt/perf/bin/dsilog 

If you are running CODA, set the property to the following value: 

DATA_LOGGING_EXECUTABLE_NAME=/opt/OV/bin/OpC/monitor/ddflog_coda 

5 Kill the hung ddflog_coda and ddflog or dsilog processes. 

Example excerpt from the SPIConfig file after setting the property: 
 
UDM_GRAPH_CAPACITY=50000 
UDM_PERF_CAPACITY=50000 
#--------- Dynamic definitions ----------- 
DATA_LOGGING_ENABLED=TRUE 
DATA_LOGGING_EXECUTABLE_NAME=/opt/perf/bin/dsilog 
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• Problem: The WBS SPI requires that PMI be enabled in WebSphere in order to gather metrics.  With 
WebSphere 4,. the SPI automatically enables PMI if it is not enabled and sets the impact level of PMI to 
that required for the metrics that the user selects.  WebSphere 5 servers have no capability for PMI to be 
enabled except from the WebSphere console.   The WBS SPI will fail if it tries to monitor a WebSphere 5 
server that does not have PMI enabled. 

Workaround: Before configuring the SPI, use the WebSphere console and enable PMI. 

• Problem: On Linux nodes, the "Configure SPI" or "Discovery" application can fail without configuring 
the SPI on the managed Linux node.  This happens because some of the configuration processes require 
uudecode to be present on the local node. 

Workaround:  Ensure that uudecode is installed on the target managed node.  It is available in the 
SHARUTILS package. 

• Problem: The "Start WebSphere" and "Stop WebSphere" applications fail on Windows nodes if the 
USER or SERVER<n>_USER configuration property is set.  The application is trying to run the "su" 
command, which is only available on UNIX. 

Workaround:  Do not set the USER or SERVER<n>_USER property when configuring the 
SERVER<n>_START_CMD or SERVER<n>_STOP_CMD properties for Windows nodes. 

• Problem: The SPI's configuration log …/wbs/log/config.log on a managed node grows without 
being managed for size.  Information is appended to this file whenever the SPI's configuration is run 
(either manually or when the discovery process finds a change that requires configure to run such as a 
WebSphere server being added or removed).  Unless there are frequent changes to the environment 
requiring reconfiguration, this should not be a problem. 

Workaround:  Manually delete the file if it gets too large. 

• Problem: For a managed node running Red Hat Linux 4, discovery and/or metric threshold monitor 
alarming is not functioning AND the following error message is found in the SPI error log: 

*** glibc detected *** double free or corruption: 0x0937d008 *** 

Workaround:  On the OVO agent, set the MALLOC_CHECK_ environment variable to 0 (zero) and restart 
the agent. 

• Problem: The WebSphere Application Server version 6.1 is supported on Windows platform only if the 
COLLECTOR_MODE is set to TRANSIENT (the default mode is PERSISTANT).  

Workaround: To set the COLECTOR_MODE to TRANSIENT, follow this step: 

Open the SPIConfig file present in /<OvAgentDir>/wasspi/wbs/conf/ directory and add the 
following line: 

COLLECTOR_MODE=TRANSIENT 

The TRANSIENT mode is resource intensive. 

• Problem: The output of Check WebSphere application displays date format in English, in all locales. 

There is no workaround for this problem, in the current release.  
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Support 
Please visit the HP OpenView support web site at: 

http://www.hp.com/managementsoftware/support

This web site provides contact information and details about the products, services, and support that HP 
OpenView offers. 

HP OpenView online software support provides customer self-solve capabilities. It provides a fast and 
efficient way to access interactive technical support tools needed to manage your business. As a valued 
support customer, you can benefit by being able to: 

• Search for knowledge documents of interest 

• Submit and track progress on support cases 

• Submit enhancement requests online 

• Download software patches 

• Manage a support contract 

• Look up HP support contacts 

• Review information about available services 

• Enter discussions with other software customers  

• Research and register for software training 

NOTE: Most of the support areas require that you register as an HP Passport user and sign in. Many also 
require an active support contract. 

To find more information about support access levels, go to the following URL: 

http://www.hp.com/managementsoftware/access_level

To register for an HP Passport ID, go to the following URL: 

http://www.managementsoftware.hp.com/passport-registration.html

Legal Notices 
© Copyright 2006 Hewlett-Packard Development Company, L.P. 

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent 
with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and 
Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard 
commercial license. 

The only warranties for HP products and services are set forth in the express warranty statements 
accompanying such products and services. Nothing herein should be construed as constituting an additional 
warranty. HP shall not be liable for technical or editorial errors or omissions contained herein. 

The information contained herein is subject to change without notice. 
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In This Version

Documentation Updates

Installation Notes

Enhancements and Fixes

Known Problems, Limitations, and Workarounds

Support

Legal Notices

In This Version


This release of WBS SPI provides:


· Support for WebSphere Application Server 6.1 (on Windows operating system, only partial support is provided. For details, refer to the section Known Problems, Limitations, and Workarounds.)

· Support for Hardware Cluster Failover

· HP-UX MCSG Cluster


· Improved error logging and fault tolerance in Discovery functionality

· Support for AIX 5.3 


· Support for Intel Xeon 64 bit processor - EM64T 

· Support for HP-UX 11.23 Itanium 

Documentation Updates


The first page of this release notes document contains the following identifying information:


· Version number, which indicates the software version.


· Publish date, which changes each time the document is updated.

To check for recent updates or to verify that you are using the most recent edition, visit the following URL:


http://ovweb.external.hp.com/lpe/doc_serv/


1 In the Product list, click the product name.

2 In the Version list, click the version number.

3 In the OS list, click the OS type.

4 In the document list, click the document title.

5 To retrieve the document, click Open or Download.

NOTE: To view files in PDF format (*.pdf), Adobe Acrobat Reader must be installed on your system. To download Adobe Acrobat Reader, go to the following URL:

http://www.adobe.com

Installation Notes


Software and Hardware Requirements


Service Navigator is not required to run the WBS SPI. However, if you want to view service maps, Service Navigator must be installed.

Management Servers


		Component

		Supported Versions



		HP OpenView Operations for UNIX




		7.1, 8.1, 8.2








Managed Nodes

		Component




		Supported Versions






		WebSphere Application Server 4.0, 4.1

		HP-UX 11.00, 11.11
AIX 4.3.3, 5.1, 5.2, 5.3 
Solaris 7, 8
Windows 2000
Red Hat Enterprise Linux 2.1 AS/ES (32 bit)



		WebSphere Application Server 5.0

		HP-UX 11.11, 11.23, 11.23 IA64
AIX 4.3.3, 5.1, 5.2, 5.3 
Solaris 7, 8, 9, 10 
Windows 2000, 2003, 2003 IA64 
Red Hat Enterprise Linux AS/ES 2.1(32 bit), 3.0 (32 bit)



		WebSphere Application Server 5.1

		HP-UX 11.11, 11.23, 11.23 IA64
AIX 5.1, 5.2, 5.3 
Solaris 7, 8, 9, 10 
Windows 2000, 2003, 2003 IA64

Intel Xeon 64 bit processor - EM64T
Red Hat Enterprise Linux AS/ES 2.1(32 bit), 3.0 (32 bit), 4.0 (32 bit) 
SuSe Linux ES 8.0 (32 bit), 9.0 (32 bit)



		WebSphere Application Server 6.0

		HP-UX 11.11, 11.23, 11.23 IA64
AIX 5.1, 5.2, 5.3
Solaris 7, 8, 9, 10
Windows 2000, 2003, 2003 IA64

Intel Xeon 64 bit processor - EM64T
Red Hat Enterprise Linux AS/ES 2.1(32 bit), 3.0 (32 bit), 4.0 (32 bit)
SuSe Linux ES 8.0 (32 bit), 9.0 (32 bit)



		WebSphere Application Server 6.1

		Note: Please see the footnote below the table

HP-UX 11.11, 11.23, 11.23 IA64
AIX 5.1, 5.2, 5.3
Solaris 7, 8, 9, 10
Windows 2000, 2003, 2003 IA641
Intel Xeon 64 bit processor - EM64T

Red Hat Enterprise Linux AS/ES 2.1(32 bit), 3.0 (32 bit), 4.0 (32 bit)
SuSe Linux ES 8.0 (32 bit), 9.0 (32 bit)



		HP OpenView Reporter




		2.x, 3.5, 3.6, 3.7



		HP OpenView Performance Insight

		5.0, 5.1



		HP OpenView Performance Manager (HP-UX, Solaris, Windows)




		4.x, 5.x








1 WebSphere Application Server 6.1 is supported on Windows only if COLLECTOR_MODE is set as TRANSIENT. See the section Known Problems, Limitations, and Workarounds for details.

Installation Requirements in a Non-Root HTTPS Agent Environment


If you are running or planning to run a non-root HTTPS agent on a UNIX managed node (OVO 8.x only), you must install the OS-dependent Sudo software package on that UNIX managed node. Sudo is free software available from http://www.sudo.ws. The OS-dependent software packages are available at the bottom of the download page (http://www.sudo.ws/sudo/download.html).


Enhancements and Fixes


None


Known Problems, Limitations, and Workarounds


· Problem: Two or more versions of the WebSphere application server are running on a managed node and discovery does not correctly set the properties for the application server(s).

Workaround 1:  


1 Verify the application servers are using non-conflicting ports. If you install an application server in a different home directory, the installer may choose a port used by an existing application server (even if you set the installer to auto-configure non-conflicting ports).


2 If application servers are using the same bootstrap port, modify the port numbers so that each application server uses a unique bootstrap port.

3 Run the Discover application.


Workaround 2:  If you want to use the same bootstrap port, run the Configure WBSSPI application and do the following:


4 Set the HOME, JAVA_HOME, VERSION, and other properties that are incorrectly set.


5 Set a unique ALIAS for each application server using the same port.


6 Unselect the AUTO_DISCOVER check box for the application server that is not running.


7 Select Finish.

· Problem: In a non-English environment, the message browser does not display error messages correctly.

Workaround:  Change the character set of the WBSSPI Error Log template and redeploy the template. For example, change the character set from “Shift-JIS” to “Japanese EUC.”

· Problem: On managed nodes using the DCE agent, the /var/opt/OV/wasspi directory and SiteConfig file are not created when running the SPI Discovery or Configuration applications.  The problem may be that the component opctranm may be hung.  


Workaround:  On the management server, run the following commands:


ovstop ovoacomm
rm –f /var/opt/OV/share/tmp/OpC/mgmt_sv/magmgr*
ovstart opc



· Problem: When multiple managed nodes are selected when running the Discover WebSphere or Configure WebSphere applications, or if the Discover WebSphere and Configure WebSphere applications are run at the same time, the SPI may report errors for one or more selected managed nodes because the SPI configuration file (SiteConfig) for one or more managed nodes has been misplaced. (QXCR1000306403: Discover/Configure application may misplace the SPI configuration file on a managed node.)

Workaround:  Run the Configure WebSphere application for each managed node that is reporting errors (run the application on each managed node one at a time).

· Problem: When the Self-Healing Info application is run on a Windows managed node, the output file may be hidden.


Workaround:  If you do not see the file, do the following on the managed node:


1 Open Windows Explorer.


2 From the Tools menu, select Folder Options. 


3 Click on the View tab. 


4 Under Hidden files and folders, select Show hidden files and folders.

· Problem: The perl installed with the OVO agent fails to find the OVO perl modules if another application (such as Oracle Application Server) sets the PERL5LIB environment variable to point at locations that do not include the OVO perl lib location.  

Workaround 1: Set the PERL5LIB system environment variable:


5 Prepend C:\Program Files\HP OpenView\nonOV\perl\a\lib (the OVO perl lib path) to the PERL5LIB system environment variable. 

6 Kill the OVO agent: opcagt -kill 

7 Restart the OVO agent: opcagt -start 

8 Check the OVO environment: ovdeploy -cmd set 

9 If the PERL5LIB variable is not set correctly in the OVO environment but the system variable is set correctly, reboot the system.

Workaround 2: 


10 Delete the PERL5LIB system environment variable. 

11 Reboot the system.


12 Run the Discover application.


Workaround 3: Run the discover script on the target node. Enter the following:

13 cd /var/opt/OV/bin/instrumentation


14 wasspi_wbs_perl –S wasspi_wbs_discovery.pl

NOTE: The service map is not generated when the discover script is run locally (is not run from the OVO management server).


· Problem: The wbs.log file grows very large.  


Workaround: Limit the size of the data saved to the log file each time the logfile encapsulator is run. In the SPIConfig file (located in /var/opt/OV/wasspi/wbs/conf/ or /var/opt/OV/conf/wbs/ on UNIX platforms and /usr/OV/wasspi/wbs/conf/ on Windows platforms), add the following:


# maximum number of lines to save to the log file / run
LOG_LINE_LIMIT=16667
# maximum number of characters to save from each log file / run
LOG_SIZE_PER_FILE_LIMIT=600000


· Problem: Two Netscape Navigator browser windows are launched when running the View Graphs application. The top window obscures the OVPM function buttons in the lower window. 

Workaround:  This problem only occurs with Netscape Navigator version 4.79. Use Netscape Navigator version 6.0 or higher.

· Problem: The Web browser cannot be launched from an operator action after you have correctly configured the WBS SPI as instructed in the “Configure the Management Server to Launch your Web Browser” task in chapter 2 of the HP OpenView Operations Smart Plug-in for WebSphere Application Server Configuration Guide. 

Workaround:  


15 Stop and restart the agent from a user other than root by entering the following commands on the managed node:


opcagt –kill
opcagt –start


16 Run the operator action. 


· Problem: Netscape fails to refresh graphing data. Specifically, when you use Netscape as the browser to graph your data (graphing capability included with Reporter 3.0 or higher), the browser fails to refresh when new selections are made. 

For example, in the OVO console after you drag and drop a managed node onto the WBSSPI Admin application View Graphs, Netscape appears and displays a blank WBS SPI graphing page where you can accept or change the following default selections:


Server: MyServer_1
Graph Name:  Serverstat
Data Range: 7 Days (ending now)


By clicking Draw, you successfully generate the graph. 


However, when you select a different server, let’s say MyServer_2, you see that the graph that appears after you click the Draw button is the same graph/data as the one you just viewed (for MyServer_1). 


 Workaround:


17 In Netscape from the Edit menu select PreferencesAdvancedCache.


18 In the segment labeled Document in cache is compared to document on network, select radio button Never.


19 After successfully generating the first WBS SPI graph, for any subsequent graphs, always change a minimum of two selections to refresh the data; for example select a different server and a different graph; or select a different graph and a different date range. Any two differing selections work to clear the current graph data from the browser cache.


NOTE: The underlined text Refresh Graph Now at the bottom of the Web page does not work; when clicked, it may return the error: the parameter is incorrect.


· Problem:  On a Solaris managed node, the ddflog and dsilog processes hang. The error message 
WASSPI-1: Unable to create the lock file /var/opt/OV/wasspi/wbs/datalog/ddflog.lck. File already exists. is reported and running the command ps –l shows that the ddflog_coda and ddflog or dsilog processes are hung.


Workaround: On each Solaris managed node on which the problem occurs, do the following:


20 In the /var/opt/OV/wasspi/wbs/conf/SPIConfig file, set the DATA_LOGGING_EXECUTABLE_NAME property after the “#--------- Dynamic definitions -----------“ entry. DATA_LOGGING_EXECUTABLE_NAME explicitly sets the data logging program that is used (normally, the collector automatically determines the data logging program to use).


If you are running OVPA, set the property to the following value:


DATA_LOGGING_EXECUTABLE_NAME=/opt/perf/bin/dsilog


If you are running CODA, set the property to the following value:


DATA_LOGGING_EXECUTABLE_NAME=/opt/OV/bin/OpC/monitor/ddflog_coda


21 Kill the hung ddflog_coda and ddflog or dsilog processes.


Example excerpt from the SPIConfig file after setting the property:

UDM_GRAPH_CAPACITY=50000
UDM_PERF_CAPACITY=50000
#--------- Dynamic definitions -----------
DATA_LOGGING_ENABLED=TRUE
DATA_LOGGING_EXECUTABLE_NAME=/opt/perf/bin/dsilog
   


· Problem: The WBS SPI requires that PMI be enabled in WebSphere in order to gather metrics.  With WebSphere 4,. the SPI automatically enables PMI if it is not enabled and sets the impact level of PMI to that required for the metrics that the user selects.  WebSphere 5 servers have no capability for PMI to be enabled except from the WebSphere console.   The WBS SPI will fail if it tries to monitor a WebSphere 5 server that does not have PMI enabled.


Workaround: Before configuring the SPI, use the WebSphere console and enable PMI.


· Problem: On Linux nodes, the "Configure SPI" or "Discovery" application can fail without configuring the SPI on the managed Linux node.  This happens because some of the configuration processes require uudecode to be present on the local node.


Workaround:  Ensure that uudecode is installed on the target managed node.  It is available in the SHARUTILS package.


· Problem: The "Start WebSphere" and "Stop WebSphere" applications fail on Windows nodes if the USER or SERVER<n>_USER configuration property is set.  The application is trying to run the "su" command, which is only available on UNIX.


Workaround:  Do not set the USER or SERVER<n>_USER property when configuring the SERVER<n>_START_CMD or SERVER<n>_STOP_CMD properties for Windows nodes.


· Problem: The SPI's configuration log …/wbs/log/config.log on a managed node grows without being managed for size.  Information is appended to this file whenever the SPI's configuration is run (either manually or when the discovery process finds a change that requires configure to run such as a WebSphere server being added or removed).  Unless there are frequent changes to the environment requiring reconfiguration, this should not be a problem.

Workaround:  Manually delete the file if it gets too large.

· Problem: For a managed node running Red Hat Linux 4, discovery and/or metric threshold monitor alarming is not functioning AND the following error message is found in the SPI error log:


*** glibc detected *** double free or corruption: 0x0937d008 ***


Workaround:  On the OVO agent, set the MALLOC_CHECK_ environment variable to 0 (zero) and restart the agent.

· Problem: The WebSphere Application Server version 6.1 is supported on Windows platform only if the COLLECTOR_MODE is set to TRANSIENT (the default mode is PERSISTANT). 

Workaround: To set the COLECTOR_MODE to TRANSIENT, follow this step:

Open the SPIConfig file present in /<OvAgentDir>/wasspi/wbs/conf/ directory and add the following line:


COLLECTOR_MODE=TRANSIENT

The TRANSIENT mode is resource intensive.


· Problem: The output of Check WebSphere application displays date format in English, in all locales.

There is no workaround for this problem, in the current release. 

Support


Please visit the HP OpenView support web site at:

http://www.hp.com/managementsoftware/support

This web site provides contact information and details about the products, services, and support that HP OpenView offers.

HP OpenView online software support provides customer self-solve capabilities. It provides a fast and efficient way to access interactive technical support tools needed to manage your business. As a valued support customer, you can benefit by being able to:

· Search for knowledge documents of interest

· Submit and track progress on support cases

· Submit enhancement requests online


· Download software patches


· Manage a support contract

· Look up HP support contacts

· Review information about available services

· Enter discussions with other software customers 


· Research and register for software training

NOTE: Most of the support areas require that you register as an HP Passport user and sign in. Many also require an active support contract.

To find more information about support access levels, go to the following URL:

http://www.hp.com/managementsoftware/access_level

To register for an HP Passport ID, go to the following URL:

http://www.managementsoftware.hp.com/passport-registration.html

Legal Notices


© Copyright 2006 Hewlett-Packard Development Company, L.P.

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard commercial license.

The only warranties for HP products and services are set forth in the express warranty statements accompanying such products and services. Nothing herein should be construed as constituting an additional warranty. HP shall not be liable for technical or editorial errors or omissions contained herein.


The information contained herein is subject to change without notice.
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